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En guide 6ver valda delar i programmet

Installera Endnote

En licens for Endnote och Endnote Web kan inforskaffas hos Helpdesk som ocksa hjalper till att installera

programmet pa din dator.

Har du inget bibliotek kan du vélja att skapa ett nytt. Ett satt att gora det pa ar att vélja File > New. Dop

biblioteket och spara filen. Kom ihag vart pa datorn du sparar det.
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Importera referenser fran databaser

Direktexport

Manga databaser har inbyggd direktexport till EndNote och andra referenshanteringsprogram. Hur
exporten fungerar kan variera beroende pa din webblasares installningar for att hantera RIS-filer. Du kan
sjélv andra de har installningarna i din webblésare eller windows instéllningar.

ACM Portal

Utfor sokningen

Referenser verfors en i taget. Klicka pa titeln.

I rutan “Tools and Resources” valj “Export formats: EndNote”
Download textfilen

Oppna filen

akrwdE

ACS Publications
1. Utfor sbkning
2. Markera valda referenser och klicka Download citations ovanfor trafflistan ELLER klick for att
oppna vald referens och ga sedan till Download citation i tools menyn till hoger
3. Valj RIS format och om du vill exportera abstract eller referenser till EndNote under include
4. Oppna med EndNote

EBSCO (Academic Search Elite, Amed, Business Source Premier, Cinahl, Communication Abstracts, Econlit, ERIC, Historical
Abstracts, Gender Studies Database, Sport Discus)

1. GOr en s6kning och valj de referenser du vill spara genom att klicka Add to folder
2. Oppna foldern (hogst upp i bla listen)
3. Markera de referenser du vill féra 6ver och klicka pa export-ikonen "%~
4. | nésta steg markerar du valet ”Direct export to EndNote, ProCite...” som ligger dverst.
5. Klicka Save och dina referenser laggs till i ditt bibliotek.
Emerald

1. Gor en sokning, valj View all... eller ga till nagon av flikarna Journals, books osv
2. Markera de referenser du vill fora 6ver till EndNote och klicka pa GO

3. Gatill Marked list i vanstermenyn och markera igen valda referenser

4. Klicka pa Export options ovanfor tréafflistan och valj Endnote

5. Oppna med EndNote — OK

Google Scholar
1. Gatill Scholar-installningar uppe i hogra hérnet
2. Under Bibliografiforvaltare langst ner pa sidan viljer du Visa lédnkar ... EndNote och spara
instéliningar
Ga tillbaka till sokrutan och sok som vanligt
For varje referens finns nu lanken Importera till EndNote
Oppna filen
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Gor en sokning, markera de referenser du vill spara

Klicka pa Download citations ovanfor resultatlistan

Vilj format ” EndNote, ProCite, RefMan” och klicka pa download
Oppna med EndNote

So6k, markera valda referenser och klicka Update marked list

Ga till Marked list I hdgermarginalen, dina valda referenser visas
Under Tools I hégermarginalen, klicka pa Export options - Endnote
Oppna med EndNote - OK

Sok och markera de referenser du vill fora over

Klicka pa knappen Download ovanfor tréafflistan

Bocka i valet ”RIS, EndNote, Procite, Reference Manager” och klicka pa download
Oppna med EndNote — OK

Utfor sokningen och markera de referenser du vill spara

Klicka pa ”Export” ovanfor trafflistan

Vaélj format RIS file (EndNote, ProCite, Reference Manager)
Oppna med EndNote - OK

Sok och markera de referenser du vill fora 6ver

Klicka pa SKAPA REFERENSER nertill pa sidan

Valj format RIS i rullgardinsmenyn och klicka pa Spara som fil
Oppna med EndNote - OK

Proquest (Biological Sciences, Linguistics and Language Behavior Abstracts, Physical Education Index,Pilots Database,

PsyclInfo, Social Services Abstracts, Sociological Abstracts, WorldWide Political Science Abstracts m.fl.)

1. Gor en sokning, markera de referenser du vill spara
2. Gatill Export/save
3. Markera Export to ProCite, EndNote or Reference Manager
4. Klicka Continue
5. Oppna med EndNote
PubMed
1. GOr en s6kning och markera de poster du vill fora dver
2. Klicka pa Send to, vélj Citation manager
3. Oppna filen med EndNote
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ScienceDirect

Gor en sokning, markera de referenser du vill spara
Klicka Export citations ovanfor resultatlistan

Valj Content format och Export format - RIS
Klicka Export

Oppna med EndNote

agkrwdE

SciFinder
1. Utfor sokning
2. Markera de referenser du vill exportera, klicka Export ovanfor trafflistan ELLER klicka for att
oppna vald referens, ga sen till Export
3. Vilj Citation export format (*.ris)
4. Kilicka Export
5. Oppna med EndNote

Scopus
1. Gor en sokning och markera de referenser du vill fora Gver
2. Kilicka pa knappen ”Export” ovanfor trafflistan
3. Irutan "Export Format” véljer du RIS format
4. Vilj format for ”Output”, t ex Abstract format
5. Export
6. Oppna med EndNote - OK

SwePub
1. Sok och markera de referenser du vill fora 6ver
2. Klicka pa SKAPA REFERENSER nertill pa sidan
3. Vilj format RIS i rullgardinsmenyn och klicka pa Spara som fil
4. Oppna med EndNote - OK

Web of Science
1. Sok och markera de referenser i trafflistan som du vill fora éver till EndNote.
2. Klicka pa ”Save to EndNote, Refman, ProCite”
3. Overforingen sker automatiskt till EndNote, om inte klicka p& Export.
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Importera med importfilter

| vissa databaser sker exporten till EndNote i tva steg, man maste vélja ratt importfilter i EndNote for att
referenserna ska importeras korrekt. Hur det har gar till beror pa vilken webblasare man anvander och
vilka installningar man har for att spara och 6ppna filer. Om man istéllet for Spara filen i sista laget kan
valja Oppna filen med Endnote kan man gora steg tva direkt. Man kommer d& automatiskt till EndNote
och far dar fragan vilket filter man vill 6ppna filen med. Nedan beskrivs steg 1 och 2 separat.

Steg 1 — s6ka och spara referenser

Cochrane (importfilter Cochrane)
1. Gor en sokning och markera de poster du vill fora ver
2. Kilicka Export Selected Results under trafflistan (eller Export All Results ovanfor)
3. Vilj Export Type ”Abstract and citation” och File Type, tex PC
4. Export Citations
5. Spara filen som kommer att heta cit-abs-plain-xxxxxx.txt ELLER 6ppna filen med EndNote

DiVA (importfilter Endnote Import)
1. Gor en sokning och markera valda referenser i trafflistan
2. Klicka pa Skapa referens
3. Vilj format EndNote, klicka pa spara-ikonen
4. Gatill Arkiv/File-menyn, vélj Spara [sida] som... text-fil
5. Se nedan for steg 2

MathSciNet (importfilter EndNote Import)
1. Gor en sokning och markera de poster du vill fora dver
2. Vid Batch Download vélj Citations EndNote och klicka Retrieve Marked
3. Gatill Arkiv/File-menyn, vélj Spara sida som/Save page as... text-fil
4. Se nedan for steg 2

Steg 2 - Importera referenserna till EndNote-biblioteket

=

Oppna ditt EndNote-bibliotek

Klicka pa ikonen for import i verktygsféltet eller ga till menyn File — Import

Klicka pa Choose file och leta upp din fil

| faltet Import Option viljer du rtt filter i listan, alla filter finns under Other filters...

Vélj Discard duplicates om du inte vill fa med dubletter

Klicka pa Import. Referenserna laggs till i ditt bibliotek men finns aven i ett tillfalligt bibliotek
Imported references

ocouaprownE
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Skriva en referens for hand

Oppna ett formulir via menyn References - New Reference, eller ikonen @

Valj typ av publikation fran rullistan Reference type och skriv sedan in de uppgifter som du vill ha med i
referensen. Olika falt blir “aktiverade” beroende pa referenstyp.

Tank pa:

Varje forfattare ska borja pa ny rad!

Skrivs in inverterat: Efternamn, Forsta fornamn Andra férnamn
Alexander, George Carl

Lee, S.Y.D.

Smith, Alfred, Jr

de Gaulle, Charles

Om forfattaren ar en firma eller myndighet skriver man ett kommatecken efter for att halla ihop
ordféljden.
Mid Sweden University,

Endnote skoter uppstallningen av referenslistan. Allt du behdver gora ar att stava ratt, fylla i
informationen pa ratt satt och valja en stil t.ex. APA.

| faltet Research Notes kan du skriva egna anteckningar.

Konvertera PDF till en referens

-

Importikon

Fran Arkiv-menyn véljer du Importera > fil eller folder for att ppna dialogrutan Importera fil.
Klicka pa knappen Valj for att lokalisera och 6ppna filen du vill importera fran din harddisk.
Leta reda pa din PDF-fil och klicka pa Oppna.

Valj PDF som Import Alternativ i listan.

Observera att det t.ex. inte fungerar pa inskannade artiklar som inte innehaller ett DOI-nummer (Digital
Object Identifier). DOI ar ett system for identifiering av verk, elektroniska artiklar.
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Sortera ditt bibliotek
Display fields
My Library ~
Du viljer vilka kolumner du vill visa i biblioteket. Edit > Preferences > Dispaly Fields. [ All References ©
B Unfiled (0)
. W Trash 0)
Search library I
| biblioteket finns en sdkruta. Du kan t.ex. sbka fram artiklar med dina dmnesord eller vilja £ Ré?"t'e:' (AL o
att séka bland PDF-filerna eller anteckningarna som du gjort i dem. @ Stickies 0]
= Papper
FILWC
Groups :

Tanken &r att du ska ha ett bibliotek som innehaller alla referenser (Show all). Det kan vara referenser
som du delar med andra via ENW. | gruppen Unfiled ser du bara dina referenser och i grupperna ser du
endast de referenser du valt att kopiera dit. En referens kan var kopierad till flera grupper.

Groups >create group (underavdelningar) eller Create group set (huvudrubrik). Underavdelningarna kan
du flytta mellan huvudrubrikerna genom att dra dem pa plats.

Keywords

Anvéands ungefar som taggar. Skriver du in egna keyword bildas en &mnesordslista. Du maste ge varje
keyword ny rad eller separera med ;

File attachments-kan goras pa flera satt

Du kan spara upp till 45 filer i en referens t.ex. pdf, word, ppt, jpeg.

e Spara forst din pdf pa harddisken. Markera referensen i biblioteket. Klicka pa ikonen for att
importera PDF i lasfonstret.

e Dra din PDF direkt till faltet File attachments.

ﬁ . EN soker i

e Markera eller 6ppna den referens du ska ha fulltext i. Klicka pa Find fulltext
olika kallor for att automatiskt ladda ner en pdf.
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Om det inte kommer nagon fulltext kan det bero pa att du inte har rattigheter till fulltexten
eller att inte open url stéds, problemet kan ocksa vara av teknisk natur. Prova da att 6ppna
din PDF pa vanligt satt och gor enligt punkt 1 eller 2.

Lagg till bibliotekets OpenUrl (http://link.libris.kb.se/sfxmiu/) for att lattare komma at vara
prenumerationer.

EndNote Preferences %
C-hange (Fase The Find Full Text feature uses several technologies to maxdimize the
- Display Fields chances that EndMote will find all available PDFs. Use this screen to
- Display Fonts control thege full text search options:
- Duplicates [¥] Web of Knowledge Full Text Links
’ . Find Full Text
- Folder Locations DO| (Digital Ohject Identfier)
- Fermatting PubMed LinkOut (UU.5. National Library of Medicine)
- Libraries
... Read / Unread OpenURL
- Reference Types e )
. OpenURL Path:  http://link libris kb se./shmiu/
- Sorting
- Syne Authenticate with:
- Spell Check

-~ Temporary Citations URL:
- Term Lists

A Examples: hitps:/ogin ezproxy librany myuniversity edulogin
- URLs & Links hittp ./ /auth universityname.edu./authentication

Dela referenser med andra

e Delareferenser via ENW
e Skicka referenser med ett mail

e Skicka hela biblioteket som en e-postbilaga

Dela referenser via Endnote Web

Skapa ett ENW-konto. Under Help klickar du pa Endnote Web. Du skickas till inloggningssidan for ENW.
Klicka pa Sign up och skriv in din epostadress. Las instruktionerna for l6senordet noga.


http://link.libris.kb.se/sfxmiu/
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My References Collect Organize Format Options
: Manage My Groups Others' Groups Find Duplicates Manage Attachments
Manage My Groups
! Number of |
My Groupst IRcicence Share
@ SCA R&D Centre 1552 _ Manage Sharing | Rename Delete |
Test group 0 [ __Manage Sharing | Rename " Delete |
_ New Group

Du kan skapa grupper som andra ENW anvadndare kan ldsa eller |dsa och dndra i genom att fylla i deras
epostadress. Likasa kan andra ge dig tillgang till sina grupper som kommer att synas i ditt bibliotek.

| EN fyller du i ditt I6seord for att kunna synka referenserna mellan webb och dator. | version X6 heter
det sync istéllet for Endnote Web. Du behover uppdatera EN X6 till version X6.0.1. Help > Endnote

program updates.

Edit > Preferences

EndMote Preferences =]
- Change Case Synchronize your data with your EndMote Web account, Learm mors
- Display Fields
- Display Fonts Upgrade or create pour bwo-year EndMate Wb account to get the latest
- Duplicates features and enable Sync.
Find Full Text
.. Folder Locations Enable Sync
Formatting
.. Libraries
Read J Unread Endiote ‘Web Account Credentials
- Reference Types .
. Sorting E-mail Address: |
> - Syne Password |
- Spell Check
- Ternporary Citations
- Terrn Lists Spnc this EndMaote Librarg
- URLs & Links C:AUsers\safpemiSaifa.enl
Sync Automaticaly:
[T] *when | open the library
“when | close the library
o Every 15 minutes -
l Endnate Defaults J I Rewvert Fanel J l [1]:8 ] l Awbiyt J I Werkstall I

OBSERVERA att i Endnote X6 synkas alla referenser fram och tillbaka mellan EN och ENW. Utom de
referenser som finns i andras grupper. Dessa maste du sjalv fora éver till din egen grupp i ENW innan de

synkas till din dator. Vill du inte att andras referenser kommer 6ver fran dina grupper som de har fatt

tillgang till kan du bara ge dem lasrattigheter.
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Skicka referenser med ett mail

| EN X6 kan du skicka referenserna med bilagan i ett mail. Markera vald referens och klicka pa
References > E-mail reference.

Du kan inte plocka in den i ditt EN program automatiskt. Antingen far du séka upp den i en databas och
importera den eller spara ner pdf:en och konvertera den till en referens.

Skicka hela biblioteket som en e-postbilaga

Klicka pa File > Compressed library sa kan du skicka via e-post eller spara ner ett komprimerat bibliotek.

Dubblettkontroll

Hitta dubbletter i biblioteket.
Vid dubblettkontroll jamfor EN foljande falt i referenserna:
Author, Year, Title, och Reference Type.

Valj Find Duplicates i Reference menyn. De referenser som ar dubbletter laggs bredvid varandra. Man

kan enkelt flytta 6ver information fran en referens till en annan genom att markera, kopiera och sedan
klistra in.

& Find Duplicates =
Comparing 1 and 2 of 2 duplicates. Skip I I Cancel
Select the record to keep. The record not selected will be moved to the Trash. Select Skip to go to the next set of duplicates.

Zakletskaia, 2011 #1 Zakletskaia, 2011 #2
Ref Type: Journal Article Ref Type: Journal Article
- R
Author Author
Zakletskaia, L. £ Zakletskaia, L. £
Wilson, E. Wilson, E.
Fleming, M. F. Fleming, M. F.
Year Year
2011 2011
Title Title

Alcohol use in students seeking primary care treatment at

Alcohol use in students seeking primary care treatment at
university health services

university health services
Journal

Journal
JAm Coll Health J Am Coll Health
Volume Volume
59 58
Issue Issue
] S 2 %
Added to Library: 2013-03-12  Last Updated: 2013-03-12 Added to Library: 2013-03-13  LastUpdated: 2013-03-13
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Endnote i Word
Né&r du installerar EN sa far du en flik i ditt wordprogram som heter Endnote.
Home SCA Insert Page Layout References Mailings Review View EndMote X5
Annotated %] Export to EndMote =

:_@\ EM Go to EndMote Styles
N :-' Edit & Manage Citation(s) = Update Citations and Bibliography

Insert .
Citation ~ 3# Edit Library Reference(s)

gEiPreferences
é Convert Citations and Bibliography ~ ? EndMote Help

Citations

Eibliogragphy Tools
A

Placera markdren i texten dar du vill
ha hanvisningen. Sist i dokumentet
skapas samtidigt en referenslista (gar
ocksa att fa for varje kapitel).

Lagg till sidhdnvisningar i textens
hanvisning genom Edit & manage
citations.

Vilj citeringsstil. | listan finns de
vanligaste stora referensstilarna
t.ex. Vancouver, Chicago, och APA.
| stilkatalogen (select antoher style)
finner du stilar for olika tidskrifter.

Nar du lagger in en hanvisning kan
du ibland behova uppdatera for att
inlagget ska synas korrekt.

Convert citations and bibliography
to Plain text. Alla dina kopplingar till
EN forsvinner men referenserna
stannar kvar. Kan inte goras ogjort!

Du kan vélja att arbeta fran ENW men
da maste du installera en plug-in fran
ditt ENW-konto till
Wordprogrammet.

Du byter uppkoppling till ENW under
Preferences >application.

Vill man snabbt se hur en stil kommer att se ut kan man i EN biblioteket klicka pa Preview. Har ser du

hur referensen kommer att se ut i den stil du valt. Regeln ar att stilarna styr hur din lista kommer att se.

Stavfel och tillagg gors i EN-biblioteket inte i dokumentet.

Ska du ta bort en referens ur listan maste du ta bort alla hdnvisningar inne i texten.

11
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Skapa en bibliografi/litteraturlista utan tillhorande
textdokument

Det kan finnas tillfallen da du vill skapa en bibliografi 6ver dina referenser utan att du har ett tillhérande
textdokument.

Print Preview

Enklaste sattet ar att dppna ditt bibliotek under File, valj print preview, skriv ut. Tank pa att stilen styr
utseendet pa bibliografin.

Copy formatted
1. Markera de referenser du vill ha i bibliografin.
2. Valjstil
3. Edit > copy formatted
4. Oppna ett worddokument och klistra in Copy Formatted

Support

Information fran Endnote och aterforsaljare i Sverige:
www.Endnote.com

www.Alfasoft.se

Support fran Mittuniversitetets bibliotek:
Endnote@miun.se

Kontaktpersoner pa biblioteket:
torun.sundstrom@miun.se (Sundsvall)

sofia.pemer@miun.se (Sundsvall)

oskar.hammargren@miun.se (Ostersund)

anders.danielsson@miun.se (Ostersund)

jonas.degerfalt@miun.se (Harnésand)
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